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The Basis Model:  A
Conventional Studio

The steps in animation      1

Let's start out with the general concepts, and then get down to
specifics…

The Steps in a Standard Animation Studio

The following drawing represents a simplified version of the various
steps in producing an animated production.  The process of
animation begins with an idea.  From this idea, the characters and
story are developed.  Once that's done, you can write your script or
scripts.  After the script is written, the cast needs to produce a
sound-track, and have it recorded onto tape or film.  The artist also
needs to begin drawing the cel and background art.  This normally
begins with line art and ends with completed character and
background art.  The chief animator writes an exposure sheet,
which correlates motion, sound, and art.  Once the exposure sheet is
written, and line art has been drawn, it is possible to run a pencil
test (a test of the animation, generally using only pencil lines), to
get an idea of what the final product will look like, and how the
characters move.  Optical press (effects added in an optical press,
where images from multiple reels of film are combines) and other
special effects (such as blurring and glows) may be added by
specifying them on the exposure sheet.  Last, the final result is
placed on tape or film.
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Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading Pencil test

Check

Correct lines

Copy to cels

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done

In the above flow chart, and in all the subsequent charts shown,
ovals indicate artistic steps, and rectangles indicate technical steps.
Arrows indicate the flow of work.  As we cover and complete various
steps, we'll show you the progress of the work as it stands, with
completed steps shown grayed out.

The Script
The script is a real script, or story-board.  Using the script, you first
decide what you are up to, what you are doing, and where you are
going with the animation.  No program can produce a good
animation for you — you need a good script.
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The Sound-Track
The sound-track is usually prepared directly from the script.  You
place the sound-track on tape or film, annotate the dialog field of
the exposure sheet from the sound-track, and animate to that.
When you work this way, and then lay the animation onto the same
tape, you always get perfect synchronization between picture and
sound.  For on-screen uses, you can digitize sound files using any
sound program you like, and add sound files into the exposure
sheet.

Cel (Character) Art
The cel layers are the artwork which are layered over the back-
ground.  What you see in each frame is the stack of cel art and
whatever background can be seen through the cel art.  By using
these cel layers, you alleviate the need to redraw the entire frame
— you need only draw what changes from frame to frame.  No
redrawing is needed to compensate for motion, rotation, magnifica-
tion, or change of aspect ratio.  Cel layers differ.  You can be stored
with transparent areas, thus, in effect, storing non-rectangular
documents.  There is no requirement that the cel layers and
backgrounds be at the same color depth, resolution, or size.

Writing the Exposure sheet
An exposure sheet is a form used by the animation industry to
denote what happens during scenes in an animation.  The exposure
sheet describes each exposure, or frame, of the animation.  The
background and each layer of the animation is called out, along
with a sound-track reference, positions and other information for
each piece of art, and notes for special effects, the multiplane
camera, the lab, the cutting room, and anywhere else work is done
on the film.  Using The Animation Stand, all of these chores are
handled immediately, and you see the result in the Current frame
window.  You'll can get a more detailed explanation of the exposure
sheet later.  The Exposure sheet Window has three possible views.
In the spreadsheet view, you get a list of frames, top to bottom.
Each frame consists of a list of layers, background to foreground,
top to bottom.  In the iconic view, you get thumbnail sketches of the
background and each cel layer used in each frame listed, left to
right.  In the grid view, you get names of the cels, listed left to right.
You can cycle between these views by clicking in the top line of the
exposure sheet.  The current Frame window shows you what the
current frame looks like at all times.

Pencil Testing
Pencil test mode allows you to see your animation on the screen at
up to 60 frames per second.
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Writing Optical Notes
The optical press emulation module allows a full range of optical
and special effects to be added to the animation.

Output
You have a wide variety of output devices available, including the
screen, tape, film, disk files, and video disk, all frame-accurate.



What a Computer Can & Can't Do for You
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There are certain steps in animation which must be done by an
artist, or the results will not be artistic.  These steps we do not
attempt to change; and we won't impose any rules which would rob
you of your artistry.  There are other steps which any technically
competent fool could do.  That's where the computer comes in.  The
computer is a very fast, very accurate idiot, and very good at math.
It will do exactly what you tell it to, and no more.

The goal we've taken in The Animation Stand is to automate the
non-artistic processes, and leave the artistry to you.  So, as we
begin our animation project, there are five steps which are going to
be the same, whether or not The Animation Stand is used.  These
steps are Concept, Storyboard, Writing the script, Drawing
the line art (first cut), and Recording the soundtrack.  Before
we go on, let's assume that these steps are complete:

Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading Pencil test

Check

Correct lines

Copy to cels

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done
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Planning Your
Hardware

Not every computer in the studio must be identical.  Each should be
tailored to its job.  We have identified three classes of machines.
The first is the master station.

The master station is the station that can do everything.  You really
only need one of these in a studio, unless there is more than one
major product being produced at the same time.  The master station
can be used for scanning, direction, paint work, and final composite
and lay-out.

The directors' stations can handle everything except scanning and
lay-out.  Normally, figure that 25% of the stations will be directors'
stations, including the master station in this count.

Paint stations cost less, and have only what hardware is required
for ink & paint work.  Normally, figure that 75% of the machines
will be paint stations.

Which Computer?

The Animation Stand runs on the Macintosh, Silicon Graphics
Unix, and Windows NT operating systems, across the range of
processors supported by these systems.  So, if you already have a
computer that runs one of these operating systems, stick with it.  If
you have some of one and some of another, stick with those, too.
The Animation Stand can share files across networks of disparate
processors.

If you're still deciding which computer to get, there are a variety of
ways, but the two major ways are (1) getting a machine that will
run all the software you want, and (2) getting the machine that has
the best price/performance ratio.  We can't tell what other software
you're interested in, but we can tell you which machine gives you
the best price/performance ratio when running The Animation
Stand:  PowerPC Macintosh.



Master Station
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There are a number of concerns for this processor, so we'll list them
out in the form of a table.  All of the items shown are recommended
configurations.  Feel free to get more or better, or to cut down a bit
for cost reasons, if required.

Item Mac SGI NT

Processor 604e R/4000 P6 or Alpha

Memory 32Mb 48Mb 64Mb

Serial ports 1 (built-in) 2 (built-in) 2

Parallel ports 0 0 1

Disk 2Gb 4Gb 4Gb

CD 1 1 1

Floppy 1 (built-in) 0 1

Wacom tablet 1 1 1

Mouse 1-button (std) 3-button (std) 3-button

Scanner 1 1 1

SCSI I/O 1 (built-in) 1 (built-in) 1

Ethernet 1 (built-in) 1 (built-in) 1

Lay-out unit 1 1 1

Net backup 1 1 1

Sound I/O 1 (built-in) 1 (built-in) 1

Monitors 2 12" 1 21" 1 12", 1 14"

Display cards 2 (built-in) 1 (built-in) 2

Software T.A.S.
ScanLink

T.A.S. T.A.S.
ScanLink
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As above, all of the items shown are recommended configurations.
Feel free to get more or better, or to cut down a bit for cost reasons,
if required.

Item Mac SGI NT

Processor 604e R/4000 P6 or Alpha

Memory 32Mb 48Mb 64Mb

Serial ports 0 1 (built-in) 1

Parallel ports 0 0 1

Disk 1Gb 2Gb 2Gb

CD 1 1 1

Floppy 1 (built-in) 0 1

Wacom tablet 1 1 1

Mouse 1-button (std) 3-button (std) 3-button

Ethernet 1 (built-in) 1 (built-in) 1

Sound I/O 1 (built-in) 1 (built-in) 1

Monitors 2 12" 1 21" 1 12", 1 14"

Display cards 2 (built-in) 1 (built-in) 2

Software T.A.S. T.A.S. T.A.S.
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As above, all of the items shown are recommended configurations.
Feel free to get more or better, or to cut down a bit for cost reasons,
if required.

Item Mac SGI NT

Processor 604e R/4000 P6 or Alpha

Memory 24Mb 24Mb 32Mb

Serial ports 0 1 (built-in) 1

Parallel ports 0 0 1

Disk 500Mb 2Gb 1Gb

CD 1 1 1

Floppy 1 (built-in) 0 1

Wacom tablet 1 1 1

Mouse 1-button (std) 3-button (std) 3-button

Ethernet 1 (built-in) 1 (built-in) 1

Monitors 1 12" 1 17" 1 12"

Display cards 1 (built-in) 1 (built-in) 1

Software Ink & Paint Ink & Paint Ink & Paint
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Track Reading

In this chapter, we will handle reading the meaning of the sound
track, or track reading, to help out the process of laying out the
exposure sheet:

Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading Pencil test

Check

Correct lines

Copy to cels

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done
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Before we can begin working on the production, we have to tell the
system what our framing rate will be.  For those who don't know,
the following are the standard framing rates:

24 Film Frame
25 PAL (European) TV Frame
30 NTSC (American) TV Frame
50 PAL TV Field
60 NTSC TV Field, HDTV Frame

The Animation Stand assumes that you are working at 30 FPS
(frames per second).  If you are working at some other speed, you'll
have to set the framing rate.  For example, let's say we want to set
the framing rate to 24 FPS.

Step 1 Bring up the Set playback dialog:

Mac: Use the mouse button to pull down the
Animate menu, and select Set playback…
from the menu, or hold down  and press the
minus key.

SGI: Use the right mouse button to display the
menus, move to the Animate menu, and
select Set playback… from the menu, or hold
ALT and press the minus key.

NT: Use the left mouse button to pull down the
Animate menu, and select Set playback…
from the menu, or hold down ALT and press
the minus key.

In the future, I'll just say "Select Set playback… from
the Animate menu.  The function-key equivalent is
minus."  On the Mac, function keys always use the 
key as their indicator.  On the SGI, the indicator key is
always ALT.  On NT, the rules are a little more
complicated.  If the function key is 0 through 9, or A
through Z, the Ctrl key is used, but if the function key
is a special character, for instance minus or comma, the
ALT key is used.  This sort of difference is forced on us
by the various operating systems, but otherwise, we
have striven to keep the products extremely similar.
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The dialog appears (Mac version shown):

Step 2 The Framing rate field is already selected.  Enter the
new framing rate, 24, in this case.

Step 3 OK the dialog by pressing the Return or Enter key.
On the Mac, you may also click on OK, or on the SGI or
NT systems, left-click on OK.

In the future, I'll just say "OK the dialog."

The Animation Stand needs to know your framing rate to work with
sound, because it's going to show you the sound frame by frame,
and let you perform all operations on the sound on a frame by frame
basis.



Make a New Exposure Sheet
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Why are we creating an exposure sheet here?  When we read a
sound track, we're using that information to annotate an exposure
sheet, so that we'll know exactly how many in-betweens we'll need,
and to otherwise help guide the action.  So, we need a big, blank
exposure sheet here to annotate.

Step 1 Create the exposure sheet by selecting New film from
the File menu, or by using function key R.  An exposure
sheet appears:
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Step 2 Right now, the only thing in the film is the End of Film
marker:  Our film is empty.  We need to add some space
in front of the End of Film marker.  To do this, we must
first select it.

Mac: Click on the "1" in the Frame column, or
anywhere in the End of Film marker.

Other: Left-click on the "1" or in the End of Film
marker.  In the future, for left-click, I'll just
say "click".  I'll specifically call out center or
right clicks.

Step 3 Select Add layers… from the Animate menu, or use
function key L.  The Add layers dialog appears:

Step 4 Determine the number of frames you need in the
exposure sheet, and enter that amount.  When in doubt,
don't worry.  You can enter the exact number, enter a
number too high and remove some later, or add too few
and use the Add layers function again later.

When you enter the frame count, you can enter in three
ways.  You can enter a number of frames, for instance,
entering "100" means 100 frames.  You can also enter a
SMPTE count, using hh:mm:ss:ff.  Of course, you can
also shorten this to mm:ss:ff or ss:ff.  For instance,
"4:10" would mean 4 seconds and 10 frames.  Last, you
can enter feet'frames.  For instance "4'10" would mean 4
feet (of 16 frames each) and 10 frames.  Any time The
Animation Stand wants a time or frame count, you can
enter your data in any of these formats.

Step 5 Press Tab to get to the Layers each field.

Step 6 Enter the number of layers in each frame.  Because we
may want a separate camera control layer and sound
track layer, it is often best to account a layer for each of
these.  Again, the number entered here does not need to
be exact.  We can add or delete (or leave unused) layers
at any time.
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Step 7 OK the dialog.  The new layers are added to the
exposure sheet.

Step 8 The exposure sheet is not yet in the format most
conducive to working with sound.  To do that, we want it
in the studio format, rather than the full-data format it's
in now.  To get there, click twice in the header bar at the
top of the exposure sheet.  The first click will change the
sheet to iconic mode, and the second will change it to
studio format.  If you click a third time, you'll be back in
data format, thus allowing you to switch formats any
time you like.



Opening, Viewing, & Hearing the Sound
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To work with a sound, we first have to bring it into the application.

Step 1 To open the sound file, select Open… from the File
menu, or use function key O.  A file open window
appears.  Since the open windows are system dependent,
we won't show one here.

Step 2 Select a file type:

Mac: On Mac, you never select a file type, since the
system knows the file types.  We won't
mention selection of file types again on the
Mac.

SGI: If the file ends with .snd or has .snd. in it,
you do not need to select a file type.  If the file
does not have a type marker, you need to click
the Sound button.

NT: In NT's Open dialog, there is a file type menu.
This menu will start out showing Pictures.
With the left mouse button, select Sounds.

Step 3 Select the file you want:

Mac: Double-click the file you want.

SGI: Left-click the file you want.

NT: Left-double-click the file you want.

The Open dialog disappears, and a sound window
appears

Instead of going through the Open process, Mac and NT give you
the option of dragging a sound file icon onto the Status window.
The Status window is the window that The Animation Stand
maintains at the left side of the screen.  (It contains all the tool
icons.)

If you just want to hear the sound, without doing anything else, the
Mac allows you to double-click it from the finder.

When the file opens, its window appears:
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The window has a header at the top, showing the fields:  Frame,
Left channel, Right channel, Beats, and Scrub.  The frame field
numbers each frame of sound.  The left and right channels show the
sound's waveform.  If there is only one channel, it will appear in the
Left column, and the Right column will be blank.  If the Right
column has a red line down the middle, stereo is present, but the
right channel is silent.

To hear the sound file, select Play sound file from the Animate
menu, or use function key 9.  While the sound plays, you will see a
red bar move down the Scrub field.  This shows you exactly what
portion of the sound is playing at any time.



Scrubbing Sounds
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You'll note that when The Animation Stand plays the sound file, it
moves a red bar through the scrub field.  This shows what portion of
the sound file the program is playing at that instant.  Since you
can't take notes that fast, we need a way to break the sound down.

You can play a portion of the file by mousing down in the scrub field
on a particular frame, and pulling down.  For instance, if you mouse
down in the scrub field for frame 10, and slowly move the mouse
downward, you will hear frame 10, then frame 11, and so on.  If you
mouse down in the scrub field for frame 10 and jerk the mouse
down 24 frames (in less than 24 frame times, or 1 second) you will
hear those 24 frames played in 1 second.  If you move up and down
in this field, you will hear that area of sound repeatedly.

This process is equivalent to scrubbing the tape back and forth
across the read head, except that there is no temporal or directional
distortion.

Now, we get to the meat of the matter.  It's time to read the track
and annotate the exposure sheet.]

Step 1 Create a new exposure sheet, as shown above.

Step 2 Add layers to it, as shown above.

Step 3 Change the sheet's display to studio format, as shown
above.

Step 4 Next, we need to synchronize a sound file to our
exposure sheet.  We do this by entering the sound into
the exposure sheet, into some layer of the exposure
sheet, in the frame in which the sound is to start,
usually frame 1.  For instance, you might decide to put
the sound into frame 1, layer 1.

Mac: Double-click a layer in the exposure sheet, in
whatever frame you chose.

Others: Center-click the layer.

The Open dialog appears.

Step 5 Select the sound file to be brought into this position.
Alternatively, on the Mac and NT systems, you can just
drag a sound file into an exposure sheet cell.  Now the
file is in the exposure sheet, but not yet open as a sound
window.
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Step 6 Now, we'll take a short-cut to open the sound file into a
sound window.

Mac: Hold down  and click on the sound file's
name in the exposure sheet.

SGI: Hold down ALT and click on the sound file's
name in the exposure sheet.

NT: Hold down Ctrl and click on the sound file's
name in the exposure sheet.

The file is now open in its own window.  The first frame
shown in the sound file's window will be the same frame
as it appears in the exposure sheet.  For instance, if the
sound file is loaded into the exposure sheet [starting] in
frame 10, then the first frame of the sound window will
also be frame 10.

Step 7 Scrub the sound, and determine the frame number of a
particular sound, or sound of interest.

Step 8 Click on the exposure sheet to make it active.

Step 9 Click in the Dialog field for the frame in which the
sound appears, and enter the text.  For instance, if in
scrubbing, you heard a bang in frame 13, you might go
to the dialog field in frame 13 of the exposure sheet and
enter "bang".

Return to step 7 until you have all the sounds you need
from this file entered into the exposure sheet.

Step 10 Close the sound file window using Close from the File
menu, or using function key W.

Return to step 4 while there are still sound files to enter
into the exposure sheet.

Step 11 We should save this sheet now, so we can use it later.
Select Save from the File menu, or use function key S.
A Save dialog appears.

Step 12 Assign the exposure sheet a name and OK the dialog.

Mac: Enter the name, and click OK.  A discerning
"Save what" dialog will appear.  Click on
Document only.

SGI: Enter the name, ending in .XSH, and click on
Exposure sheet.

NT: Enter the name, and click OK.  An extension
of .XSH will be used.
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Step 13 To print the exposure sheet, select Print from the File
menu, or use function key P.

Marking Beats

Beats are places in the sound where something significant happens.
Using The Animation Stand, you can mark these beats in the sound
file, and save this beat annotation by saving the file.

To mark an individual beat, click in the beat field for a particular
frame.  The beat field is between the right channel and the scrub
field.  It shows a triangular beat mark which is added or removed
by clicking in a given position.

To mark beats while the sound is playing, press the spacebar once
at each beat.



Seeing Sounds

22    The Animation Stand

As strange as this sounds, after only a few hours of working with
this type of sound display, you will begin to recognize wave forms,
an no longer need to do a lot of scrubbing, and may not need to do
any at all.  All of this reduces track reading to a simple, straight-
forward task:

Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading Pencil test

Check

Correct lines

Copy to cels

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done
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General topics      23

At this point, based on our previous work-flow diagram, you
probably expected to go on to creating the exposure sheet; but in
computer animation, we really have to have the drawings in the
computer at this point for things to make sense.  Thus, we will add
the step of scanning; but don't worry—this will save us several
steps later.  One obvious step is copying the lines to cels.  Once the
line art is scanned into the computer, we can print cels at any time:
As lines, as colored lines, as painted cels, or as fully shaded cels.
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In a real production, you have to set up your scan parameters, scan,
and get on with the project.  However, since we're just learning, and
not yet even setting up, we have time to discuss the two major
options, black-and-white versus grayscale scanning.  On the chance
that you need to get going on your production right now, read this
chapter, but skip the "grayscale" option and go straight on to the
"black and white" scan option.

In black and white scanning, we scan the document at high
resolution, but only using pure black and pure white.  The
advantage here is that there are no "edge effects" (we'll get into that
later) to deal with, but the disadvantage is that the images tend to
be rather large, and take a tiny bit more time to composite.

In grayscale scanning, we scan the document at a lower resolution,
using shades of gray.  Note that not all scanners can do this.  This
allows us to take edge effects into consideration, which is required if
we want a pencil (rather than pen) look, or in other cases were line
shading is important.  The advantage to grayscale scanning is that
the images are smaller and composite faster, but may be edge
effects we'll have to compensate for.  More on that later.

Color scanning is required for painted backgrounds, or if you are
compositing already-painted cels.  If you are compositing against a
live-action background, do not scan photo-rotos.  Instead, load the
entire film or tape as a QuickTime movie (or series of RLA files, on
the SGI), and composite fully digitally.  Note that not all scanners
can handle color.

Which one to use?  Before production begins, try both black and
white and the grayscale techniques on just a few frames, say 1
frame from each of three scenes.  If one looks better than the other,
use that.  If they look the same, just pick one.
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There are two ways to scan:  Using ScanLink™ and using other
scan software.  Since we make ScanLink, we'll describe that.  Some
of the scanning concepts, such as brightness, are universal, and
appear in just about any scanning program.  Others, such as line
patching, are unique, and may not appear anywhere else.

Setting up you scan parameters requires knowledge about your
scanner, your production, your computer, and about your paper.

First, let's consider DPI, or dots (pixels) per inch.  Here, we must
first know the number of dots across the paper.  Here are the
factors:

Step 1 The basic number of dots across the paper will be the
number of dots across the production.  The number of
dots across the production is simple to calculate.  For
TV, each given tape format has a given number of dots
across.  For instance, in NTSC ß-Cam, the screen image
is 648 x 486 pixels, so we have 648 dots.  For film, we
are dealing with the film printer's concept of dots across
a frame.  On some film printers, you get to tell the
printer, while on others, they tell you.  The most
common number of dots across are 1,536, 2,048, and
4,096, although 1,024 and 8,192 are also available.

Step 2 Next, we need to know the zooming factor.  Let's say
we're dealing with a 12 field basis (12" paper), and the
camera is set to 12 field (field of view of 12", or 100%
apparent magnification).  We're at 1:1, so there's no
need to apply any correction factor to our dot count.
However, if we zoom in on a piece of art, we need to
multiply the zooming factor.  If we come in 2:1, which is
the same as 200% magnification, or 6 field, we need to
multiply by that factor of 2 (2:1=2; 200%÷100%=2;
12ƒ÷6ƒ=2).  In our example, that's 1,536 x 2 = 3,072
dots.

Step 3 Next, we need to apply an antialiasing, or super-
scanning factor.  This takes extra information from the
paper, which will be used to clean up the image later,
giving us a more natural look.  For fine resolution,
multiply by 2.  For super-fine resolution, multiply by 4.
Normally, you'll use 2 here.  In our example, this gives
us 3,072 x 2 = 6,144 dots.  If the drawing will only be
used for pencil testing, and will never be used for
anything more, skip this step.
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Step 4 Next, we need to apply a limiting factor.  This factor
applies only to Macintosh, and should be alleviated in a
future version of the Mac OS or by future versions of
The Animation Stand, but for now, characters which are
to be flat shaded have a limit of 16,368 pixels across,
and characters which are to be smooth shaded have a
limit of 4,092 pixels across.

Step 5 Divide the number you got (for instance, 6,144) by the
number of inches (for instance, 12, giving 512 DPI for
this example).  The number you get may be much lower
than you'd expect if you've done print jobs, so don't be
too surprised.

Step 6 Again, we need to apply a limiting factor, this time for
the limitations of the scanner.  Scanners have only
certain DPIs at which they can scan.  For instance, some
scanners scan at 75, 150, 200, 240, 400, and 800 DPI
only.  On such a scanner, you can't scan at 512 DPI.  In
this case, we would have to switch to 800 DPI.  On other
scanners, you can use anything between 100 and 400
DPI.  In this case, you'd be stuck with 400 DPI.  Most
scanners, however, allow you anything between 50 and
800 DPI, or even 1,600 DPI.  You don't actually have to
check these numbers in ScanLink, as it will correct DPI
values to legal values without complaint.



General topics      27

Now, we're ready to start the scanning process.

Step 1 Choose Scan… from the File menu.  The Scan dialog
appears:

Step 2 Select the scanner you're going to be using from the
Scanner menu.

You have the option of having ScanLink track registration holes for
you.  If you are not going to have ScanLink spot registration holes
(for instance, you are using a peg bar), skip to step 11.

Step 3 Place a blank piece of paper in the scanner.

Step 4 Click Learn.  The computer will scan the sheet and
decide on the paper size.  If the machine does not beep,
and changes the paper size fields and the registration
point fields, you're fine.  Skip to step 7.  If it beeps, you
have to enter these fields manually.
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Step 5 Manual entry of paper size:  You can either enter the
paper size in the From bottom, From left, Height,
and Width fields, or just click on Full.  The Full button
tells the scanner to scan its full flatbed size.  The From
bottom field tells the scanner how many pixels, mm,
inches, cm, picas, or feet to skip scanning at the bottom
of the paper.  For instance, if we wanted to scan starting
1" from the bottom of the page, at 72 DPI, we could
enter 72, 1", 0.083', 25.4mm, 2.54cm, 0.025m, or 6pi.
Similarly, the other three fields define the other scan
size restraints.

Step 6 Manual entry of peg information:  You also need to enter
the distance from the bottom of the scan to the center of
the peg holes.  This does not have to be an exact
number, but it should be correct to 1/8" (3mm).  This
value goes in the second Center of peg hole field.  You
also need to enter the distance from the left side of the
scan to the center of the left peg hole.  Again, there is
some tolerance, and this number goes in the first
Center of peg hole field.

Step 7 You also need to enter the amount of image to clip out
after the peg hole recognition step, so that the peg holes
will not be retained in the computer's files.   This value
goes into the Off bottom field.

Step 8 Click on the Register checkbox to turn it on.  This will
have the computer spot registration holes for you.  Note
that to use registration, the scanner must be able to see
black behind the paper.  On some scanners, you will
need to affix a piece of electrical tape approximately 1cm
x 2cm behind the scan position used for the registration
hole area.  On other scanners, you may have to
disassemble the feed mechanism and spraypaint large
portions of the scanner black.  If you do not turn this
setting on, you will also have to scan one drawing at a
time (see next step), and use a peg-bar.

Step 9 Click on the Multiple scans checkbox to turn it on.
This tells ScanLink to keep scanning until the scanner
runs out of paper.  Of course, you need a sheet feeder to
make this work.

Step 10 Enter the numbering scheme into the Hold field.  For
instance, if the drawings are numbered c1, c2, c3…, the
drawings are numbered by ones.  Enter a 1 into the
Hold field.  If the drawings are numbered c1, c3, c5…,
the drawings are numbered by twos, and you would
enter a 2.
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Step 11 Enter the DPI, as computed above.

Step 12 Click on Clean up to turn on the clean-up functions.
These functions declutter the image, removing black dirt
specs from the image, and patch lines, which means that
ScanLink will remove white specs in black areas, and
patch almost-closed lines for you.  The only reason you
would not turn this checkbox on is to save a little time
while you are scanning documents that will only be used
for pencil testing.

Step 13 Enter the name of the first item to be scanned.  For
instance, in the above examples, the first drawing was
to be numbered c1.  In this case, you would enter c1 into
the Name field.  Alternatively, instead of entering data
into the Name and Hold fields, you could use OCR.
This feature allows you to have the computer read the
drawing names directly from the paper, and skip
entering Name and Hold.  See the reference manual for
a full description of OCR.

Step 14 Place your paper into the scanner.

Step 15 Click on Scan or press Return or Enter.  The computer
will scan until it runs out of paper, or scans its single
sheet, if no feeder is in use.

Return to step 13 until the project is scanned.
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Grayscale scanning is much like black and white scanning, with
just a few differences:

Select Grays from the Depth menu.

The Intensity and Contrast fields have effect on most scanners.
These work the same way they do in you TV.  128 is a middle
setting with 0 or 1 being the low end, and 255 being the high end.
On some scanners, 0 has a special meaning.

The Clipping level slider has significance, too.  This bar has two
sliders on it.  One starts at black, and the other starts at white.
These are used to reject certain grayscales.  If you move the left
slider in, then there will be a range of blacks and dark grays to the
left of the slider.  All of these blacks and dark grays will be treated
as 100% black.  Similarly, if the right slider is moved in, all the
light grays and whites to its right are treated as 100% white.  This
allows you to ignore certain minor variations in ink & paper color
and lighting.

In step 3 of the determination of scan DPI, leaving the number as it
is gives us fine resolution, and doubling the number gives us super-
fine resolution.  This means that we will be scanning at half the
DPI of black and white scans.

In step 4 of the determination of scan DPI, the Macintosh limit will
always be 4,092 pixels, as we will always be using 32-bit painting.

Setting Up Color Scan Parameters for Backgrounds

Color scanning is much like grayscale scanning, with just a few
differences:

Select Color from the Depth menu.

Skip step 3 of the determination of scan DPI entirely.
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You should have a folder or directory called Art.  In Art, have a
folder for each project.  In those folders, have a folder for each
scene.  You may want to have folders in the scene folders for layers,
but again maybe not.  This will depend on the length of the scene
and the number of layers.  Place the scans in these folders.  Try to
give the cels simple names.

On the Mac, all the files will be stored as Picture (PICT) files.

On the SGI, all the files will be stored as T.A.S. files, so you should
end the file names with ".TAS".

On NT, the files will be stored as TAS files if you specify a .TAS
extension or no extension, and in some other format if you specify
another extension from the following list:

.BMP Bitmap

.TGA Targa

.TIF TIFF

.RLA Wavefront RLA

Having added (and handled) scans, and removed copying to cels
(since that's now just a print command), our new flow chart is…
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Concept Storyboard
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Producing a Pencil Test

The three steps directly involved in producing a pencil test are (1)
coding the exposure sheet, (2) producing the pencil test, and (3)
checking it:

Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading

Pencil testCheckCorrect lines

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done

Scan



Concept:  The Exposure Sheet Window & the Current Frame
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When you create a new exposure sheet, two windows appear.

The exposure sheet is where you create your animation.  That is,
you tell The Animation Stand which pictures (or cels) to put in the
frames in your animation, and how to move those pictures from
frame to frame.

The exposure sheet can appear in three forms.  In the spreadsheet
format (default), frames are displayed top to bottom, and within the
frames, cel layers are displayed top to bottom.  In the iconic and
studio formats, frames are still listed top to bottom, but layers
within the frames are listed left to right.  In this document, I'll be
using the studio format fro descriptions.

The exposure sheet window describes every frame of the film being
created.  It shows all frames in textual form, a spreadsheet of sorts.
Changes made to the current frame window will change the
exposure sheet immediately.
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The current frame window shows the contents of the current frame,
graphically.  The current frame is always defined as the frame
containing the spreadsheet cell being edited, if any, or the first
selected frame, if any.  Barring that, the “current frame” is usually
the frame that last fit one of those criteria.  Changes made to the
exposure sheet, or any file appearing in the current frame will
change the current frame window immediately.  This includes
changes made to artwork made through other programs, on your
machine or another machine on a network.  Changing your
selection in the exposure sheet may change the definition of the
current frame, and may thus cause the current frame window to
update.

At the top of the current frame window is a controlling area which
shows which layers are selected for modification in the current
frame window, as a series of file (drawing) names, highlighted for
selected layers.

All of these windows can be used to edit the film.  The exposure
sheet window is used for textual, spreadsheet edits, while the
current frame window allows direct moves of picture elements.

In the Status window, there are sets of tools which can be used to
affect the current frame window and the exposure sheet.  The tools
which control the exposure sheet are accessed via the pop-up icon:

Next to this icon is another icon, showing the current tool in use in
the current frame window.  It leads to a window of tools, too.

In this section, I'll first show you how to create the bare minimum
exposure sheet, using the absolute fewest number of techniques,
and then add techniques one at a time.  Each new technique will
require you to remember a little bit more, but will also save you
some time; so whether or not you want to read into those techniques
is up to you.
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There are really two concepts in building the basic exposure sheet:
Setting up the overall parameters, and building the sheet.  Let's
start with the parameters:

Step 1 We need to set our framing rate, and a number of other
playback parameters to optimize for pencil testing.
We're actually going to start before we start running
The Animation Stand.  The very first step is to optimize
the screen for the fastest possible playback.

Mac: Invoke your Monitors control panel (which
may have another name).  It may vary from
system-version to system-version, but on my
Mac, I need to select Control panels from
the  menu, and then double-click the
Monitors control panel item.  Then, I select
my main screen, and set its depth to Black
and white if you scanned in black and white,
and 256 colors if you scanned in grayscale
with a 256-color scanner, or 16 colors if you
scanned in grayscale with a 16 color scanner,
and its Color/ Grays selector to Grays.
Close the control panel and the control panel
window.

SGI: This step is not required.

NT: From the program manager, open the Main
window, and from there, open Control
Panels item.  From there, open the Display
item.  From there, click List all modes.
From that list, select black and white, or the
lowest number of colors available.  If modes,
rather than number of colors are listed,
choose VGA if you scanned in black and white
or 16 grays.  If you scanned in 256 grays,
choose Super VGA or SVGA.  OK the modes
dialog and the Display dialog, and then close
the various windows.

Step 2 Start The Animation Stand.  If running on the SGI, use
the 32-bit version, tas.
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Step 3 Select Set new cel size… from the Options menu, or
use function key 1 to get our first Dialog.  We're actually
going to have to go through a few to get optimal pencil-
test performance.

Step 4 Enter the width and height into the top two fields.  For
instance, 648 x 486 for NTSC ß-Cam, or perhaps 1536 x
1k for film.

Step 5 OK the dialog.
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Step 6 Select Set playback… from the Animate menu, or use
function key minus:

Step 7 Turn on Frame #s, so that we will see frame numbers
in the pencil test playback, making corrections easier.

Step 8 Turn on Loop, so that we can loop the test, and be more
able to observe errors.

Step 9 Enter the framing rate, if other than 30 FPS.

Step 10 Select Full screen from the Where menu, so that when
we play back a test, we won't have the computer
interface obstructing our view.

Step 11 Select Notes=WHITE from the Display menu if the
scans were scanned as black and white, or Notes=
MINIMUM if the scans were grayscale.

Step 12 If, when calculating the scan DPI, you doubled the scan
resolution for antialiasing (or other) purposes, you must
select ÷2 from the Size menu.  If you quadrupled the
DPI, select ÷4.  If you are using film resolution, and your
output is larger than the screen, you'll have to reduce
the image size even further.
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Step 13 OK the dialog.

Building a Basic Exposure Sheet

Now, we're ready to set up the actual exposure sheet.  Normally,
you will have one sheet per scene, but the actual arrangement is up
to you.  Below are the instructions for the exposure sheet.  You will
go through these steps once for each sheet.

Step 1 Select New film from the File menu, or use function
key R.  A new exposure sheet appears, with a current
frame window behind it.

Step 2 Set the sheet into studio format by clicking in the
header bar ("Frame Label…") twice.

Step 3 So far, we don't have room on the exposure sheet for
anything.  We need to create some blank spaces.  Click
on the End of Film marker to select it.

Step 4 Choose Add layers… from the Animate menu.

Step 5 Enter the number of frames to add.  When in doubt,
guess high.

Step 6 Tab to the next field.

Step 7 Enter the maximum number of layers in the scene;
guess if you don't know.

Step 8 OK the dialog.  Now, you've got a sheet with a certain
number of frames, numbered 1 through whatever, and a
certain number of layers, numbered BG, 1, 2, 3, etc.  So
far, all the exposure sheet cells are blank.

The positions of items in this exposure sheet mirror the positions in
a paper sheet:  One frame of final product per line, one layer of
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background or animation per column.  For each cell in the exposure
sheet to be filled in, use either steps 9 and 10 or step 9a.

Step 9 We need to tell The Animation Stand to edit the cell in
question.

Mac: Double-click the exposure sheet cell.  The
Open dialog appears.

Others: Center click the cell.

Step 10 Find the file you want, and double-click it.

Step 9a You may be able to drag items into the exposure sheet:

Mac: You may drag a file or "file promise" from the
Finder, Find File, or any other drag-aware
program directly into any exposure sheet cell.

SGI: Dragging is not available.

NT: You may draw a file from the File Manager,
or any other drag-aware program directly into
the exposure sheet.

As I mentioned before, these are the bare minimum steps; we'll get
more efficient a little bit later in this chapter.

To add more room in a sheet later:  You can add more room before
any frame, or before the End of Film marker by clicking in the
Frame column, at the left of the sheet, and then invoking Add
layers…, or you may add one frame at a time, by center-clicking
(double-clicking on the Mac) in the Frame column at the left of the
exposure sheet.

To remove a portion of the sheet later:  You can remove a group of
frames by clicking and dragging through a group of numbers in the
Frame column at the left of the sheet, and then pressing the Delete
or Clear key.  If there's just one frame to delete, you can just click,
rather than click and drag.  If you want to remove a particular
layer, click on it, and press Delete or Clear.
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Now that we've completed our first sheet, its time to take a look at
it.  First, let's save it.  Also, it's a good idea to save a sheet in
progress from time to time.  We suggest saving every 10 minutes.

Step 1 Select Save from the File menu, or use function key S.
The Save dialog appears.

Step 2 Enter a name.  On SGI and NT, you should use the
.XSH extension.  Of NT, you get it automatically.

Step 3 OK the dialog.  On Mac, you'll also have to click on
Document only when the Save what dialog appears.

Now, we can safely proceed.

Step 4 Select Play or record from the Animate menu.  There
will be a pause while some items are preloaded into
memory for speed.  Then, playback will begin.  Since we
selected looping, the playback will go on indefinitely.

Step 5 Press and hold down Escape to stop the playback.

Playback in this manner may or may not be at the required speed.
Remember, it's just compositing when you ask, so you're looking at
the actual composite speed.  I'll have more on real-time playback
later.
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Once you've looked at your test, you will probably have a few
frames you'd like to look at more closely.  You can use the exposure
sheet to examine individual frames.  Here's how:

Step 1 If the exposure sheet is not the frontmost document,
click on it to bring it forward.

Step 2 Click on a frame, anywhere in the frame.  The current
frame window will display that frame.

You can also use the current frame window to display frames.

Step 1 If the current frame window is not the frontmost
document, click on it to bring it forward.

Step 2 Next, we will need the current frame window's toolbox.
If you look to the left, at the Status window, you will see
the icon of the Current frame window tool in use:

Although we can access tools as if in a menu, for these
purposes it will be better to pop these tools up as a
toolbox:

Mac: Mouse down on the current frame tool area,
and then draw the mouse through the drag
bar of the tool window that appears, changing
it from a menu to a window.

SGI: Click in the current frame tool area,
displaying the current frame tools in the
toolbox at the right of the window.

NT: Right-click in the current frame tool area,
bringing up the current frame toolbox.
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Step 3 Now, you can click the playback icons to move about:

Rewind brings you to the first frame in the exposure
sheet.

Fast forward brings you to the end of the exposure
sheet, namely the End of Film marker.  You can then
back up to see frames at the end.

Step back and Step forward each step forward or
back one frame.

Play plays the film from the current point.
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Using the Exposure Sheet
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If all of your cels are always set on the same pegs, and there is
never any movement from 0-0, you can skip this section; but if
things are going to move, read on.

This section shows how to modify the position of art under the
camera from the animating director's point of view, namely, from
the exposure sheet.

In a conventional exposure sheet, there is just one positioning
column, and the camera man is supposed to understand or guess
which layer or layers the move is meant to control.  Unfortunately,
when working with computers, we don't have the luxury of allowing
the machine to make artistic decisions.  For that reason, each layer
in our exposure sheet has a number of positioning columns.  To
work with the positioning columns, it is better to work in the full
data view of the exposure sheet.  To get from the studio view of the
sheet to the full data view, click once in the heading bar at the top
of the sheet.  (Later, when we want to get back to the studio view,
click twice in the heading bar.)  Now, rather than listing layers
from left to right, The Animation Stand lists the layers from
background to foreground.

Now, you get a number of columns of data on each layer:

The Frame field shows which frame we're on, and is used in
selecting frames and layers.  The Label field we've already
discussed in regards to sound.  The File field represents the sound
file is use, or the background or cel layer file in use for this item.
The Hold field represents the number of times we will shoot the
frame.  Thus, you can adjust timing by changing the Hold field.  A
blank Hold field (actually, a value of 0, which is not displayed)
means that the layer is not the last layer in the frame.  The + and
Mod fields are used in cycling, and will be discussed later.  The
Notes field has two uses.  First, you can put any sort of notes into
the Notes field you like, and second, any special effects or
compositing requests are placed into the Notes field in all capitals,
so that the computer can carry out these requests.
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The Top and Left fields control how far from the top and left of the
frame the drawing is displayed.  If you leave these two fields blank
(actually, values of 0, which are not displayed), the drawing's top
edge will appear at the top of the frame, and the drawing's left edge
will appear at the left edge of the frame.  When you enter numbers
into these fields, as pixels, picas (pi), metric (mm, cm, m), or
English measure (", '), the item in the layer will be moved.  Use
negative numbers to move up or left.

Actually, we are not directly controlling the placement of the
drawing's top left corner.  We are controlling the registration point,
which is normally in the top left corner.  More on registration points
later.

The Mag and V.Mag fields control magnification, squash, and
stretch.  Normally, these fields contain 100 and 0, respectively.  It is
important to remember that when the magnification field contains
100, it will not be displayed, and that when V.Mag contains 0, it
will not be displayed.  How you use these fields depends upon what
you're doing.

Magnification: You can enlarge a layer by setting its
magnification (Mag field) to larger than 100%.
You can reduce a drawing by setting its
magnification to less than 100%.  V.Mag is not
used.

Squash & stretch: You can squash and stretch an object by setting
its vertical and horizontal magnification
numbers separately.  For instance, let's say we
wanted to show a character twice as tall and
half as wide as he normally is.  We would set
the Mag field (horizontal magnification) to 50,
and the V.Mag field (vertical magnification) to
200.  On NT, you can get mirror-imaging in the
vertical or horizontal dimensions by setting
Mag or V.Mag to a negative number.

You can rotate a cel by setting its °R field.  °R is the number of
degrees the object is rotated about its registration point.  Positive
numbers are clockwise, and negative numbers are counter
clockwise.

Each time you finish making a change, the current frame window
updates to show that change.  You can force an update by clicking
in the Frame field.
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There are two ways in which a registration point might be
somewhere other than the corner of the drawing:  You can set it, or
ScanLink may have set it.  Remember that if you scan with
Register selected, the registration point will be moved the center of
the left Acme hole.

There are some important differences between setting a registration
point and moving a drawing.  If a drawing appears just once, and
you move the registration point down 1", that's the same as moving
the drawing up 1" in the exposure sheet.  But, if the drawing
appears more than once, changing the registration point will affect
how the drawing is placed each time the drawing is placed.

It affects resizing, squashing, stretching, and rotation in that these
effects all occur about the registration point.

Set the registration as follows:

Step 1 Open the image file:

Mac: -click the file's name in the exposure sheet.
The file opens into a paint window.

SGI: ALT-click the file's name.

NT: Ctrl-click the file's name.

Step 2 Click on the registration point tool in the status window:

Step 3 Click in an area in the paint document to establish a
registration point there.  A crosshairs appears.  Also,
note that as soon as you make the change, the current
frame window will update, if it uses this drawing.

Step 4 Save the file again, using Save from the File menu, or
function key S.

Step 5 On Mac, you'll also have to click on Document only
when the Save what dialog appears.
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This section will deal with making changes to the animation from
the cameraman's point of view.  When you look at the current frame
window, you are looking through the camera.  Your final
presentation, tape, or film will consist of exactly what you saw in
the current frame window.

The current frame window also allows you to change what you see.
The window consists of two portions.  Across the top are numbers,
each one representing a layer.  In the bottom portion (approx-
imately 95% of the window), you see the camera's view.

To make any changes, you must first select one or more layers.  You
can select a single layer by just clicking on it.  Selected layers turn
yellow.  You can select multiple layers by holding down Shift and
clicking on additional layers.  You can also turn on or off layers by
pressing keys 1 through 9.  If you click a white layer, it turns
yellow.  Click a yellow layer, and it turns red.  Click a red one, and
it turns white again.  These colors indicate the selection mode:

White: Not selected.

Yellow: Selected.  Any tool you use will affect the drawing in the
frame shown.  Normally, this is the selection type used.

Red: Selected over time.  Any tool you use will affect the
drawing in the frame shown, and in all other frames
selected (yellowed) in the exposure sheet.  If you've got
just one frame selected in the exposure sheet, then red
selection is the same as yellow.

At this point, the various current frame tools will select how the
mouse will affect the current frame window's view:

Move allows you to move the selected layer(s) about in the
frame.

Copy is the same as the Move tool, except that only one
layer (the last one selected) is moved, and the layer is
copied.

Stretch modifies the V.Mag field.  Mouse down in the
content area, and drag to reshape the layer(s).

Resize modifies the Mag field.  Mouse down in the content
area, and drag to resize the layer(s).

Rotate modifies the °R field.  Mouse down in the content
area, and drag to rotate the layer(s).
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Earlier, I had you filling in the exposure sheet cel by cel, frame by
frame.  You were probably thinking that there must be an easier
way, and you'd be right.  This section and the following will give you
ways that are easier, in many circumstances.

Let's say that you have an animation that has a background, named
BG, and a foreground item named FG, with the files actually named
FG1, FG2, and FG3.  Here's one way of setting up the sheet, as
described above:

Step 1 Edit frame 1, layer BG to specify file BG (or drag)

Step 2 Edit frame 2, layer BG to specify file BG (or drag)

Step 3 Edit frame 3, layer BG to specify file BG (or drag)

Step 4 Edit frame 1, layer 1 to specify file FG1 (or drag)

Step 5 Edit frame 2, layer 1 to specify file FG2 (or drag)

Step 6 Edit frame 3, layer 1 to specify file FG3 (or drag)

Simple in concept, but a bit time-consuming.  When a layer is
selected, either because you just edited the cell, because you clicked
on it, or because you dragged something into it, you can use the 0,
+, or - keys to copy the item down to the next frame.  0 keeps the
name as it was; + (actually, you don't have to shift, so we could call
this the = key) adds 1 to the name; and - subtracts 1 from the name.
On SGI and NT systems, it's the name that's changed, not the
extension.

For instance, adding 1 to XYZ1 gives XYZ2.  Adding 1 to XYZ9 gives
XYZ10.  Adding 1 to XYZ09 also gives XYZ10.  Adding 1 to XYZ1A
gives XYZ1B.  If the name ends in a special character or Z, you can't
add 1 to it.  Subtracting 1 from XYZ10 always gives you XYZ09.
Subtracting 1 from XYZ1B gives you XYZ1A, but subtracting 1 from
XYZ1A gives you XYZ1.

We can use these keys to simplify our example.  This time, we can
use:

Step 1 Edit frame 1, layer BG to specify file BG (or drag)

Step 2 Press 0 twice to copy BG into the BG layer of frames 2
and 3.

Step 3 Edit frame 1, layer 1 to specify file FG1 (or drag)

Step 5 Press + twice to copy FG2 and FG3 into layer 1 of
frames 2 and 3.
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There's another way to speed entry:  Using function keys in the
Open dialog to fill out more cells in the exposure sheet.  Again, I'll
use the same example:

Let's say that you have an animation that has a background, named
BG, and a foreground item named FG, with the files actually named
FG1, FG2, and FG3.  Here's one way of setting up the sheet, as
described above:

Step 1 Edit frame 1, layer BG to specify file BG

Step 2 Edit frame 2, layer BG to specify file BG

Step 3 Edit frame 3, layer BG to specify file BG

Step 4 Edit frame 1, layer 1 to specify file FG1

Step 5 Edit frame 2, layer 1 to specify file FG2

Step 6 Edit frame 3, layer 1 to specify file FG3

This time, we'll use the special keys to simplify the work load:

Step 1 Begin the edit of frame 1, layer BG.  When you select the
file, hold down the Shift key.  This will select the file
BG into the correct position, and start an edit on the
same layer in the next frame (still the BG layer, but now
for frame 2) and leave the Open dialog window open.

Step 2 Shift-select the BG file again.

Step 3 Select the BG file a third time, this time dropping it into
frame 3.

Step 4 Begin the edit of frame 1, layer 1.  This time, hold down
a special key while selecting FG1:

Mac: Option

SGI: ALT

NT: Ctrl

The special key will cause the open dialog to go down
the sequence of cels, FG1, FG2, FG3… until it runs out
of files in the sequence, or runs out of space in the
current layer to put them.
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Very often, we have simple sheets, where everything follows a
particular pattern.  For instance, let's say we have a 30 frame sheet.
The background for each of the 30 frames will be BG, and the
background will be unmoving.  The character layer will be CHAR1
through CHAR30, but not all of the drawings are used.  We're using
CHAR1, CHAR3, CHAR5, CHAR7, CHAR9, CHAR10, CHAR13,
and then CHAR14 through CHAR30 on twos.  And in front of it all
will be a dancing bug, moving from left to right (with slow in and
slow out, of course), cycling BUG1 through BUG5.

As we've seen above, you could use the direct entry method to
specify all 90 items, one by one, and position the bug in 30 frames,
one by one (eyeballing in the current frame window, or with your
calculator in the full data view in the exposure sheet window), or
you could use the 0 and + keys to speed your work, but there is a
way to greatly speed the process up.  The following step by step
guide shows how we would make a sheet for this example.

Step 1 Create the exposure sheet using New film from the
File menu, or function key R.

Step 2 Put the sheet in the studio view, if it's not already there
by clicking twice in the heading bar.

Step 3 Create a new, empty frame by center-clicking (double-
clicking on Mac) the End of Film marker.

Steps 4-6 Enter BG, CHAR1, and BUG1 into the BG, 1, and 2
layers of the sheet, by center-clicking (double-clicking on
Mac) the lays' cells in frame 1 and selecting them from
the Open dialog.  Now, you've got one frame created.

Step 7 Either through the exposure sheet's data area or in full
data view, or through the current frame number, we
have to place the bug in his initial position for frame 1.

Step 8 Because this bug cycles in 5 drawings, switch to the full
data view (by clicking in the header bar at the top of the
exposure sheet window), and enter 5 into the Mod field
for the bug layer.

Step 9 We could go on to create 29 more frames this way, but it
would be better to have the machine help us out.  The
next step is to duplicate this first frame for us, so that
we can make modifications.  Mouse down on the 1 in the
Frame field at the left of the BG layer, and move the
mouse down to the Frame field corresponding to the bug
layer, selecting all three layers.
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Step 10 Select Copy from the Edit menu, or use function key C
to copy the frame into the clipboard.

Step 11 Select Paste before from the Edit menu, or use
function key ] to paste in a new copy.  We use Paste
before, rather than Paste, because Paste replaces our
selection with the new data, rather than just inserting
the data.  Now, we have frames 1 and 2, both identical
copies.

Step 12 What is now frame 2 will become frame 30 later, when
we add some frames between frame 1 and this frame.
So in frame 30 (still numbered frame 2), change the +
field for the CHAR1 layer to 29.  When The Animation
Stand decides which file to use in this position, it will
use CHAR1+29, or CHAR30, which is the file we wanted
to use in this position.

Step 13 Still on frame 2, change enter 29 into the + field of the
bug layer.  This says that we're going to use the original
drawing of the bug, and advance 29 times, but repeat
after 5 (from the Mod field).

Step 14 Use the exposure sheet or the current frame window to
place BUG5 in its terminal position.  You now have two
completed frames.

Step 15 Here's where the shortcut happens:  Click on the
exposure sheet pop-up icon:

The exposure sheet tool set appears:
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Step 16 Drag the Move tool (pictured below) onto the first layer
of frame 2, indicating that we're inserting a move
between frame 1 and what is currently frame 2.

The Move dialog appears:

Step 17 Our next step is to enter the timing values here.  Since
we're adding 29 frames after frame 1 (including frame 2
or 30), the numbers entered into this dialog should add
up to 29.  For a purely linear move, you would enter 0
for Slow in and Slow out, with a Hold time of 29 (or
1:05 or 1'13, if you're so inclined); but since we want
some slow in and slow out, I think that Slow in and
Slow out values of 6 would be nice, which leaves us
with a Hold time of 17.  Then, OK the dialog.

Step 18 Your move is made, but now appears as a Move marker.
You can consider yourself done, or you can expand the
Move marker to individual frames by clicking on the
Move marker, and then selecting Expand from the
Animate menu, or using function key E.
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There are also other, special types of moves.  A Pantograph moves
allows us to set up a specific move, over a series of frames.  The
move can be controlled either by placing a marker controlling where
the background and each cel will be in each frame, or you can set up
paths in the "follow me" mode, where you show it the path and the
timing.  (We'll also handle spline moves later on, where just one or
two [or more] control points will control an entire range of motion.)

Using a pantograph move is much like using the Move tool, with
some changes at the end:

Step 1 Set up the exposure sheet, including the before and after
frames.

Step 2 Drag the Pantograph tool onto the first cel of the ending
frame:

A dialog appears asking how many frames are to be in
the move:

Enter some number of intermediate (or “in between”)
frames, not the total number of frames involved in the
movement.
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Step 3 OK the dialog.  This dialog will disappear and the
Pantograph dialog will appear:

Step 4 Move the shoot points to the positions you'd like them:
The circles represent points which cannot be moved —
the points in the frame before and after the Pantograph
set.  The squares represent the locations occupied by the
layer's registration point for various frames (3 in this
case).  You may drag the “shoot squares” to any desired
position.

If you select Drawn path, rather than drag a shoot position, you
draw the motion of the layer.

If there is more than one layer in the set, there is also a layer menu,
which allows you to choose which layer will be affected.
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A spline move is similar to a pantograph move, except that in this
case, we have only a few control points, and the computer draws a
smooth curve for us.  There's less control, and less work.  This
technique is not available in conventional animation, but it can be a
time-saver over pantograph or manual entry methods.

Using a spline move is much like using the Pantograph move tool,
with some minor changes:

Step 1 Set up the exposure sheet, including the before and after
frames.

Step 2 Drag the Spline tool onto the first cel of the ending
frame:

The Interpolation dialog appears asking how many
frames are to be in the move.
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Step 3 Enter the number of intermediate (in-between) frames,
and OK the dialog.  The Spline dialog will appear:

Step 4 Again, you have to set up the control points:  The circles
represent points which cannot be moved — the points in
the frame before and after the Spline set.  The squares
represent the curve's control points.  You may create
new control points and drag them to any desired location
(using the Add point function), drag existing control
points about (using the Move point function), or delete
control points (using the Delete point function).  All of
these functions are available from the Function menu.

If there is more than one layer in the set, there is also a layer menu,
which allows you to choose which layer will be affected.
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So far, the view you've has of the animation has been limited to a
very slow playback rate:  The actual time it takes to composite each
frame.  Depending on your machine, it may have been able to show
the work at the proper speed, but it's unlikely.  To get a useful look,
you have to prepare a real-time file, and then play that file back.
This is done with a full-speed run, or a QuickTime movie file.

Full-speed run files will show every frame of the film on the screen.
If they fall behind, they will attempt to catch up.  If any one frame
was as late as 4ms (0.004 seconds), you will get an alert on the
screen warning you of this.  Here's the machine-specific small print:

Mac: For most work, this is your best real-time format.  Looping is
not required in most cases.  Be sure to use real memory,
rather than virtual memory.  You can control this with the
Memory control panel.  Also, make sure as much space as
possible is allocated to the program.  The more memory, the
better it runs.

SGI: Use this format.  Since the SGI is a virtual memory system,
have looping on.  The first time the system plays the file, it
may be a bit slow, but it should catch up on the second run-
through.

NT: Full-speed run is not available.  Use the simple playback
function.
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QuickTime movie files also attempt to show every frame, but there
is a difference in how QuickTime handles speed problems.
QuickTime always remains real-time on the sound track.  It keeps
the picture track real-time, too, but if it falls behind, it will leave
one or more pictures out, to catch up.  This will have the visual
effect of freezing the picture for an instant.  Also, QuickTime movies
are not as efficient at full-speed run files under most circumstances.
However, if a full-speed run file gets too large, it becomes very slow,
while a large QuickTime movie still plays well.  Again, here's the
machine-specific small print:

Mac: If you have a QuickTime accelerator card, you should use
that packing format.  Also, you can use various video edit
systems to output the QuickTime file directly to tape.

SGI: QuickTime output is not available.

NT: QuickTime output is not available as of this writing, but we
are expecting Apple to provide for this facility shortly.  Read
this section through, as what applies to QuickTime will also
apply to AVI files.  We'll cover QuickTime as we expect it to
work, since it will likely be in place by the time you read
this.

Now that you've gotten the basics, we can go ahead and see the
final product.
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Step 1 Select Set playback… from the Animate menu, or use
function key minus.  The Set playback dialog appears:

Step 2 Set the Framing rate, if you have not already done so.

Step 3 Turn on Loop, if you haven't done that.

Step 4 If you're using QuickTime, set the Key frame rate field
to 8.  Don't worry if you don't see this field.  It will likely
be gone in future versions.

Step 5 If you're using a QuickTime Codec card, select the name
of that card from the Compressor menu.

Step 6 Also if you're using QuickTime, set the Compression
slider all the way to Accurate.
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Step 7 How you generate the file will depend on your machine:

Mac: Select Save as Full-speed run… or Save as
QuickTime movie… from the Animate
menu, or use M or \, respectively.

SGI: Select Save as Full-speed run… from the
Animate menu, or use ALT-M.  When giving
the file name, it's best to use the .FSR
extension.

NT: Select Save as… from the Animate menu, or
use Ctrl-M.  When giving the file name, use
.MOV for QuickTime output (when available)
or .AVI for AVI file output (if and when
available).

Step 8 To play the file back, open it.  If you're on an AV Mac,
you can use the video out jack to make a VHS or S-VHS
copy at the same time.
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This section is for those who need to lay out a 100% frame-accurate
version of their work, with absolutely no rough-cut timing artifacts.

Step 1 Bring up the Set playback dialog using Set playback…
from the Animate menu, or use function key minus.

Step 2 Select what type of hardware you'd like to use from the
Where menu.

Step 3 If you are using a Lyon-Lamb or VAS device, or a Sony
laser disc, you must pick a coding method from the
Coding menu.

Step 4 Enter a tape position into the SMPTE field.  The
exception to this step is a device in step 3 in VIFC mode.
In that case, you'd use a frame count in the Tape posn
field.

Step 5 If you're using a V/LAN video controller network, you'll
have to enter the node number of your chosen V/LAN
receiver into the Node field.

Step 6 OK the dialog.

Step 7 Save your exposure sheet.  Feel free to save early and
often, but step 8 requires it.

Step 8 If your sheet is set at 24 FPS, but your equipment runs
only at 30 FPS, we need to convert the exposure sheet to
30 FPS.  We do this by selecting 3/2 frame pulldown
from the Animate menu.  Remember not to save this
modified exposure sheet, unless you want to work at 30
FPS for the remainder of the project,

Step 9 Select Play or record from the Animate menu, or use
function key J.

Exception:  From any type of machine, if you are using a Perception
board, save to it as .RLA files.  If you are running on a network,
save to the perception board over the network.  It will appear as a
disk from Mac, SGI, and NT.
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Sometimes it is easier to move the camera around than it is to move
the art.  To make this kind of thing easier, we provide two methods
of moving the camera around in The Animation Stand.

First, there is the FRAME command.  When we're not using the
FRAME command, the background goes in the first layer (called
"BG"), and the cel layers start in the next layer (called "1" and so
on).  Using the FRAME command, we place a camera icon in the
first layer (BG), the background in the next layer (1), and cel layers
starting in the next layer (2 on).  The camera icon shows up in the
data view as "FRAME" in the Notes field.

You get the camera icon into the layer by dragging it from the
exposure sheet tool window, or center-dragging (option-dragging on
the Mac) it to a layer to place it into that layer in all frames.  Once
this icon is in place, any move you make to the FRAME layer is like
moving the camera.  So, if we set magnification to 200%, then all
the layers show up at 200%.  The same holds for movements and
rotations.

A second method to control positioning is with frame notation.  This
is best used from the full data view.  In this method, you enter
frame move notation.  Here's how it works:  You enter frame move
notation into the Notes field.  When you leave the field (by pressing
Enter, or whatever), the action takes effect.  The notation is best
shown by example.  Let's say you enter "#12 1N-2W".  This means
that the camera is to stay at 12 fields (we use a 12-field basis), and
move its view 1 field north (up), and 2 west (left).  If we wanted to
zoom in at the same time, we might code (for instance) "#8 1N-2W".
If we wanted to use some other basis, such as a 16-field basis, we
would enter "#8 1N-2W (16)".
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So far, I've shown how to check an entire exposure sheet all at once,
or check a single frame.  But what if you just want to check a
portion of the animation?  Easy!

Go back to the Set playback dialog, and you'll find two controlling
fields, Frames and Layers.  Each of these field contain an asterisk,
meaning all fields and all layers.  In each of these fields, you can
also enter a range.  For instance, if you entered "20-50" into the
Frames field, and "2-" into the Layers field, this would mean that
playback would show only frames 20 through 50, and that each
frame would omit the first (background) layer, and show layers
starting at the second.

Field Guides

You can call up a field guide at any point by selecting Field
guide… from the Options menu, or use function key F.  Enter the
number of fields in the guide.

You can dismiss the field guide by entering 0.

But Wait, There's More!

All that's been shown here is a direct carryover from conventional
techniques.  In the reference manual, you'll find many more
techniques and tools.
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Here's where we stand now:
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Correcting & Cleaning
Lines
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Normally, in animation studios these two steps can be handled
separately, or in combination.  Since, for the most part, cleaning up
is handled automatically by fine-tuning the scan parameters, we'll
skip that step and concern ourselves with correcting lines.  Any
cleaning still to be done can be handled as a correction.

Loading a File

The first step in modifying the lines of a cel is to get the cel into the
computer's memory.  There are two ways to do this.  If there is an
exposure sheet open, and file name appears on the sheet, you can
hold down the function key (  for Mac, ALT for SGI, and Ctrl for
NT), and click on the file name.  Alternatively, you can select
Open… from the File menu, or use function key O, and select the
file that way.  On Mac and NT systems, you also have the option of
dragging the file onto the Status window.
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Let's say you are going to modify FROG5, and you'd like to see
FROG4 and FROG6 at the same time, for reference.  Here's what
you'd do:

Steps 1-3 Open FROG4 through FROG6.

Step 4 Click on the FROG5 window, so that it becomes the
frontmost.

Step 5 Select Light table… from the Options menu, or use
function key 6.

Steps 6-7 Select FROG4 from the Light table A, and FROG6
from the Light table B menu.

Step 8 OK the dialog.

When you want to eliminate the light table effect (you can close the
file without this step, if you want):

Step 1 Select Light table… from the Options menu, or use
function key 6.

Step 2 Click on None.

Selecting a Pen Nib

When you draw, you draw with the currently selected pen nib.  This
nib is shown as the upper left icon in the Status window.  The
default is a single pixel pen, which is fine for most purposes.  If you
need a thicker line, follow these directions:

Mac: Mouse down on the nib icon.  A menu window appears,
showing various preset nib sizes.  Drag the mouse to one and
release the mouse.

SGI: Click on the nib icon.  A list of various nib sizes appears on
the right side of the Status window.  Click one.

NT: Right-click on the nib icon.  A menu window appear, showing
various preset nib sizes.  Right-click on one of them.
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This is pretty easy, too.

Step 1 Select the eraser tool:

Step 2 Erase with it.

Adding New Freehand Lines

Another easy one.

Step 1 If you have a pressure-sensitive tablet, you might want
to turn off pressure sensitivity.  If you leave it on,
pressing harder or lighter will make thicker or thinner
lines, with darker or lighter coloration.  Bring up the
Preferences dialog by selecting Preferences from the
Options menu, or use function key 2.

Steps 2&3 Turn off the Pressure affects width and Pressure
affects flow checkboxes.

Step 4 OK the dialog.

Step 5 Select the draw tool:

Step 6 Draw with it.
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There's a type of curve, called a "spline" curve, which is much like
drawing with a "French curve" tool.  In concept, each spline curve is
made up of one or more segments.  Each of these segments has two
fixed end points, and one or more "control" points.  A segment with
only two control points is a straight line:

A segment with one control point arcs towards the control point:

A segment with multiple control points arcs towards each of them:
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You can use multiple fixed and control points to design any number
of figures.  For instance:

The thick lines shown will be dropped into the document when we
finish editing the curve.  The width of these lines is controlled by
the selected pen nib size.  The lighter lines show how the fixed
points and control points connect, and will not be made part of the
document.  Control points show as blue boxes, and fixed points
show as red boxes.  Neither of these items will be dropped into the
document, as they are only used for control during the drawing
stage.

To use these tools, bring up the Curve tool window, controlled by
the Curve icon:

Mac: Mouse down on the Curve icon, and move the mouse through
the drag bar, tearing off the window.

SGI: Click on the Curve icon, placing the curve tools in the right
side of the Status window.

NT: Right-click on the Curve icon, bringing up the Curve tool
window.
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Here's how each of the tools work:

This is the first tool you'll use for making a spline.  Each
time you draw with it, it will draw a new, unconnected
segment.  The segment will have two new fixed points at
its ends.

This tool adds a new fixed point wherever you use it in
the document.

This tool adds a new control point wherever you use it in
the document.  When you use the first spline tool, that
tool will automatically switch you to this tool, since
adding control points is what you'll do in 99% of the
cases.

This tool deletes whichever control or fixed point you
click on.

This tool allows you to mouse down on a control point or
fixed point and drag it about.

Rerunning the Pencil Tests

Here's where things get extremely nice:  To rerun the pencil test,
just bring up the exposure sheet (if it's not already up) and use
function key J to run it or shoot it again, or one of the "Save as"
functions to save out a QuickTime movie, Full-speed run, or series
of pictures.

If you had the exposure sheet open while you were modifying files,
then you probably saw the frames change as you made modifica-
tions to the file, or as other people on your network modified the
files.
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Again, we've covered very few of the retouching functions in The
Animation Stand.  Consult the reference manual for a full list.

Here's our standing on the project so far:
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We need to handle the palette before we go on to any ink or paint
steps.  At some studios, you have a palette once and for all, and
that's it.  At other studios, you develop a palette for each project.
Either way, you'll need a palette at this point.



The Default & Prebuilt Palettes
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Each time you mouse down on the foreground color marker:

You'll see the palette appear:

From this palette, you can pick the next color you're going to use.
When you first run the application, The Animation Stand will use a
default palette.  On the Mac, this is the System color palette.  On
SGI and NT, it is a maximally-spaced palette.

In case you'd like to use other palettes, we've included those for you,
too.  To get to those:

Step 1 Select Open… from the File menu, or use function key
O.  The Open dialog appears.

Step 2 Get to the palettes directory:

Mac: Select Palettes.

SGI: Maneuver to directory /usr/TAS/Palettes.

NT: Maneuver to directory C:\TAS\PALETTES.

Step 3 NT only:  Set your file type filter to Palettes.

Step 4 Open any of the palette files you find there.
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Almost certainly, you will want to build a custom palette.  Here's
how:

Step 1 Bring up the standard or current palette, as shown
above.

Step 2 Pick a palette cell you'd like to change.  Center-click it.
(on the Mac, double-click it.)  The color picker appears:

Don't panic!  It only looks complicated.  The color picker
allows you to modify your colors, while showing you a lot
of information.
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Step 3 Enter or modify your color for this cell.  Here's what the
various controls do:

Red, Green, & Blue entry fields:  These fields take a
color level.  On the Mac and SGI 64-bit versions, these
numbers range from 0 to 65535.  On the SGI 32-bit and
NT versions, these numbers range from 0 to 255.  0 is
the minimum value, meaning no red, green, or blue.
The highest value represents the component (red, green,
or blue) at 100% intensity.

The Red, Green, & Blue sliders:  These sliders allow
you to set the color intensity graphically.  The colors
along the bar show you what color you'll be on if you
move the slider to that position.

Other color sets:  Each of the other triples allow you to
modify the same color, using different color spaces.
Hue/Saturation/Value is the color scheme used on the
standard color wheel.  Hue/Luminance/Saturation is
the color model used in NTSC TV.  It's best to keep satu-
ration under 75% for broadcast NTSC TV.  Cyan/
Magenta/Yellow is used in print work.  The black
component is computed for you.

At the lower left is a box containing the current color.

On Mac, there will be a button allowing you to
substitute one of the Mac standard color pickers for this
color picker.

On SGI, there will be an additional slider which controls
the transparency level of the color.  This transparency
level is not used directly in painting, but is kept for later
use in the compositing stage.

Step 4 OK the dialog, changing the color.

Step 5 Repeat the process at step 2, until you've created the
colors you need.

Step 6 Select Save as… from the File menu.



Opticals      77

Step 7 Enter the file name you'd like to assign to the palette
and OK the dialog:

Mac: Use any name you like.  OK the dialog.  You
will be presented with a second dialog, asking
what to save.  Select Palette only.

SGI: The file name should end in .tas.  Click on the
Palette only button to save the file.

NT: Use any name you like, but the name must
end in .TPT.  OK the dialog.

You can also load colors from scans:

Step 1 Open the scan.

Step 2 Select the eyedropper tool:

Step 3 Use it to select a color by clicking on it.

Step 4 Select the color store tool:

Step 5 Click on a palette cell.

You can use this technique for some palette cells, and the color
picker for others, if you like.

Screen Palettes, Printer Palettes, & Film Palettes

The computer screen produces its own light.  Print media reflect
ambient light.  Movies absorb light from a tungsten bulb.
Unfortunately, this means that colors in each medium will look
different.  Many companies use one, two, or three palettes; one for
each medium they use.  You don't need to worry about this in the
paint stage, but be aware that you may need additional palettes
later to make everything look perfect.



But Wait, There's More!

78    The Animation Stand

As you might expect by now, there are many more palette functions
than I've shown here.  Read the reference manual for more
information.

Here's our current status:

Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading

Pencil testCheckCorrect lines

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done

Scan



Ink
Common questions      79

We'll handle inking in a separate section, since not all of you will be
using colored lines.

There are two reasons to use colored lines.  One is a purely artistic
reason:  You like to compliment colored areas with a certain color of
line.  The second reason is  self-colored lines, usually to separate
out an area in shadow, or a shaded or highlighted area.  Either way,
the same technique is used to highlight the lines.

Overall flow

Normally, we'll be going through groups of cels, inking them all at
once.  Here's the general flow, for each group to be inked:

Step 1 Open your palette.

Step 2 Use the Open dialog to open the first cel in the sequence.

Step 3 Ink the cel using one of the techniques below.

Step 4 Invoke the Next cel function from the File menu, or use
function key 8.  This will save the current cel, close it,
and open the next cel in the sequence.  If you are at the
end of the sequence, no cel will be opened, and you're
done.  If there is more to do, the cel opens, and we
return to step 3.



Inking All the Lines in One Color
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Follow these steps to set all the lines to one color:

Step 1 Select the color from the palette.

Step 2 Select the Lightest color mode:

Mac: Mouse down on the Mode icon, which appears
on the Status window as a green circle over a
red circle:

And drag to the Lightest color mode icon,
which is a pink circle covering a red circle:

SGI: Click the Mode icon, then the Lightest color
icon.

NT: Same, but use right-click.

Step from now on, any time a tool, color, mode, or nib is
to be selected from a list menu, we'll skip the description
of how to drag, click, or right-click.

Step 3 Pick Select all from the Edit menu, or use function key
A.

Step 4 From the Paintbucket list (on the Status window):

pick the Paint selected area tool:

It will immediately color all your lines.



Inking Lines Separately
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When you need to ink just a few lines, or lines in different colors,
follow these steps for each line:

Step 1 Pick the color from the palette.

Step 2 Pick a pen nib approximately the same width as the
line.

Step 3 From the Draw tools list:

 (gray tool with a black squiggle)

Select the Line draw tool:

 (gray tool with a red squiggle)

Step 4 Draw over your lines.  As you draw, you will see a line
being drawn 3 times as large as your selected nib.  This
is so that you don't have to be careful about covering the
line.  When you release the mouse, portions of this
colored area you've just draw which cover the existing
line are retained, and portions which fall on white
disappear.  If you slop over the wrong area, don't worry
— Just use Undo from the Edit menu, or function key
Z.
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Paint

At this point, we're ready for paint.  But, because of the way paint
and shade interact in The Animation Stand, we'll handle several
painting steps at once:

Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading

Pencil testCheckCorrect lines

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done

Scan



General Flow for Manual Paint
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Normally, we'll be going through groups of cels, painting them all at
once.  Here's the general flow, for each group to be inked:

Step 1 Open your palette.

Step 2 Use the Open dialog to open the first cel in the sequence.

Step 3 Paint the cel using one or more of the techniques shown
below.

Step 4 If you never use white as a paint color, and you scanned
your lines using pure black and white, skip ahead to
step 8.  If you use white, or used grayscale lines, you'll
have to establish a selected area, or the computer won't
know the difference between white that counts as paint
and white that does not.  From the Selection tools list:

Pick the Shrink to fit tool:
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Step 5 If there are no enclosed white areas, skip ahead to step
7.  An enclosed white area generally occurs when a
character puts his hands on his or her hips, or holds
something.  For example:

©Allied Visual Artists

This character has four enclosed areas.  There's on
between the hair and the neck, one between the elbow
and the back, and two at the feet.  Here, we need to drop
the white area out.  From the Paintbucket tools, pick the
Paint with selection tool:

Step 6 While holding down the minus key, click in the enclosed
white areas, one at a time.  Each time you do, the minus
key indicates that the white area needs to be subtracted
from the currently selected area.  Continue this process
until there are no enclosed white areas.

Step 7 You must save this area explicitly.  Use Save area from
the file menu, or use function key =.
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Step 8 Invoke the Next cel function from the File menu, or use
function key 8.  This will save the current cel, close it,
and open the next cel in the sequence.  If you are at the
end of the sequence, no cel will be opened, and you're
done.  If there is more to do, the cel opens, and we
return to step 3.

Flat Shading

Flat shading means that the entire shaded area is the same color.

Step 1 Select the appropriate paint tool.  Use the standard
paint-bucket for art scanning in black-and-white, and
the Edge-filling paintbucket for work scanned in
grayscale

 or 

Step 2 Click in each area to be painted.



Nailing Those Annoying Little Enclosed White Areas
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Sometimes, a drawing will have a line that results in areas which
are very small, either intentionally, or because two lines are very
close:

©Time-Warner, Inc.

Here, intentional areas occur at the ribs and boots, and uninten-
tional areas occur at the cape pleats:
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You can take care of the unpainted white areas all at once.

Step 1 Select your paint color from the palette if you have not
already done so.

Step 2 Select the Darkest color mode from the mode list.  This
icon is a red circle covering a pink one:

Step 3 Select a medium-to-large size nib from the pen nib list.

Step 4 Slop color onto the white areas.  Don't worry about areas
already painted, or the lines.  When you release the
mouse, the extra paint will disappear.  Again, if you slop
too far, you can Undo.



Line-Controlled Highlights & Shadows
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Here, we start with a drawing with lines showing where the shades
and highlights go, and work from there.

Step 1 Open your palette.

Step 2 Open the drawing:

Step 3 Select the line-coloring tool.

Step 4 Color your lines with an adjoining color:

Step 5 Select the Paintbucket tool.

Step 6 Paint in the appropriate colors:
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Step 7 Pick the Lasso tool from the selection tools:

Step 8 Select an area around the inside lines, by drawing a
selection line around the painted edge.

Step 9 Center-click (or option-click on the Mac) the blur tool:

This brings up a dialog asking how far to blur.  For this
example, I've entered 5 and got this:

On subsequent uses, you can just click the tool, to
proceed without edit.



Wash-Controlled Hightlights & Shadows
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This technique uses the equivalent of a watercolor wash to control
how to highlight.

Step 1 Open your palette.

Step 2 Open the drawing:

Step 3 Select the Paintbucket tool.

Step 4 Select the base color.

Step 5 Paint in the base color(s):

Step 6 Bring up the Modes window for editing.  This only has to
be done once, in many circumstances:

Mac: Mouse down on the Modes icon in the Status
window, and when the window pops up, drag
through the window's drag bar, tearing it off.

SGI: Click on the Modes icon in the status window,
bringing up a mode list in the right side of the
window.

NT: Right-click the Modes icon in the Status
window, bringing up the Modes window.
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Step 7 Center-click (double-click, on Mac) the Spherical wash
mode icon:

This brings up the mode's edit dialog:

Step 8 Click towards the left side of the wash's display area,
shifting the highlight to the left.  This matches our
previous examples.

Step 9 OK the dialog.

Step 10 Pick a highlight color from the palette.

Step 11 Paint into the document, applying the highlighting:



3D Highlights & Shadows
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This technique uses the equivalent of lighting to control how to
highlight and shade.

Step 1 Open your palette.

Step 2 Open the drawing:

Step 3 Select the Paintbucket tool.

Step 4 Select the base color.

Step 5 Paint in the base color(s):

Step 6 Pick the Fill with selection tool from the Paintbucket
list:

Step 7 Click it in an area to be shaded.  Alternatively, you
could use other selection tools, such as Lasso.  You can
make your selections cumulative by holding down the
Shift key.
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Step 8 Center-click (or double-click on Mac) on the Sphere tool
to edit 3D lighting:

The 3D lighting dialog appears:

Although a lot appears on this dialog, there's not much
we really have to concern ourselves with right now.  A
complete description of the lighting dialog appears in
the reference manual.

Step 9 Click on the 50/50 button, which tells the system that
we want half room lighting and half spot lighting.

Step 10 The large oval controls where the light strikes the area.
If you move the small spotlighting circle up, the light
comes from the top.  Move it down and the light comes
from the bottom.  Move it left or right, and the lighting
source moves to the left or right, eventually looping
around behind the object.  While you move the light
source, the light's coordinates are displayed in the
Status window.  For this example, I used a right ascen-
sion of 45°, and no declination.

Step 11 OK the dialog.
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Step 12 Select the Relight tool from the 3D tools:

It immediately relights your selected area:



Automatic Painting
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So far, everything has been done manually.  That is, you tell the
computer to do a single operation, and it does it.  However, things
are better than that.  Using Auto-Paint, you can paint large
numbers of cels quickly.

Here's the flow of work in Auto-Paint:

Step 1 Open the palette as you normally would.

Step 2 Just to be safe, select Clear all from the Edit menu.
This clears any instructions we may have inadvertently
left around for Auto-Paint.

Step 3 Open the first cel in the sequence.

Step 4 Paint it up as you normally would.

Step 5 Use Next cel to go on to the next cel.  Of course, when
you run out of cels, no new cel will open, and you're
done.

Step 6 Select the Move bucket from the Paintbucket list:

Over each previously painted area, diamond-shaped
paint chips appear.  Each of these paint chips
remembers the paint color used in that position, the
mode used, and certain other factors.

Step 7 If the paint chips are all still over the same areas they
had been over in the previous cell, skip to step 9.
However, they might not be.  One by one, drag each of
the paint chips into the areas they should paint.  If you
used washes or the like, there will be a paint chip for
each color painted into the area.

Step 8 If there are any paint chips for areas which no longer
appear, select the Delete bucket tool:

And click on each of the extra paint chips to delete them.
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Step 9 Click on the Auto-Paint tool:

Each of the paint chips will, in order, repaint this cel
like the last one.

Step 10 Select the regular Paintbucket:

 or 

And paint any newly-appeared areas.  Return to step 5
while there is still work to do.

Working Close-In

At any time, you can zoom in on a piece of work to get a closer look
by following these steps:

Step 1 Click on the Magnifying glass tool in the Status window:

Step 2 Click in the document.  The document zooms into that
point in a new window.  (Except on NT, where the
document zooms within the window.)

Step 3 Do whatever work you have to do.

Step 4 Close the window.  (Except on NT, where you center-
click to zoom back out.)

Making & Using Character-Model Palettes

There's another type of palette which we haven't yet used:  The
character model.  Here, you paint a small version of your character
and save it like a normal cel file.  Later, to use it as a palette, select
Open as palette… from the File menu.  The file will appear as a
floating palette window, and you can select colors directly off of it.
If you need to edit this palette later, use a normal Open… to access
it for edits.



But Wait, There's More!
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So far, we've touched on only the smallest fraction of The Animation
Stand's paint component.  There are a huge number of paint tools,
most of them with editable features, and a large number of modes.
Plus a large number of features in the Options and Effects menus.

Here's our standing, so far, after changing shading to a simple step:

Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading

Pencil testCheckCorrect lines

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done

Scan



After Painting
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Now, there's a little clean-up work to do.  We need to make some
changes to the exposure sheet.  Namely, we need to bump up our
resolution so that everything is clean and moves well, and we need
to account for our compositing techniques.

Step 1 Open the exposure sheet, if it's not already open.

Step 2 Each cel scanned in black and white and saved with
Next cel, but without Save area needs the WHITE
note in the Notes field.  Bring up the animated tools
palette by clicking on the animated tools icon:

Step 3 Drag the White transparency mode onto a particular cel
in the sheet:

Or hold down  on Mac, ALT on SGI, or Ctrl on NT,
and drag the White transparency mode onto a cel in the
sheet.  In this latter case, it will affect all items in that
column of the exposure sheet.

Step 4 Each cel scanned in grayscale (and thus saved with
Save area) needs the Darkest line method (DARKEST
in the Notes field).  The easiest way to do this is to
switch to the full data mode, and enter DARKEST into
each of the Notes fields.

Step 5 Pick Set playback… from the Animate menu, or use
function key minus to bring back the controlling dialog.

Step 6 Pick 4:1 from the Resolution menu.

Step 7 Turn off Looping and Frame numbers.

Step 8 OK the dialog.  Now, you're ready for final.

Step 9 If you feel like it, pick Play or record from the
Animate menu, or use function key J.  The painted
film, without special effects, will play or record.
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Concept Storyboard

Script

Draw line-art

Exposure sheet

Clean lines

Record soundtrack

Track reading

Pencil testCheckCorrect lines

Ink lines

Paint colors Paint shadows Paint highlights

Paint selection

Shoot film

Check

Shoot opticals

Optically combine

Done

Scan



Special Effects
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There are a large number of special effects that The Animation
Stand can perform for you in a single command.  Most of these
effects fall into animation stand effects, multiple head optical press
effects, or video effects categories, but some are hard to categorize.

Among the more recognizable effects The Animation Stand
performs are (in no particular order) live action compositing, drop-
out of certain colors (such as white or black), edge clean-up, green-
and blue-screen, colorization of lines (for pencil tests), fades &
blends, wipes, matting, color correction, focus effects, gels, double-
exposures, and drop-shadows.

Below, I'll give two examples of optical effects.



Effects from the Current Frame Window:
Dropping a Shadow
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The Animation Stand can drop a shadow for you.  Like most effects,
shadowing needs to know where the character's edge is.  This
means that if the character or cel was not saved using Save area,
it needs it.  You can always go back to the cel (for instance, by
holding , ALT, or Ctrl and clicking its name in the exposure
sheet) and resave it using Save area.

Let's take as an example a character over a background, and we
want to add a shadow.  I'm going to show these examples in full
data mode so that you can see everything that happens.

Step 1 Set up the basic frame.
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Step 2 Go to the current frame window.  Since we want to apply
a shadow to the Fawn07 cel, and that cel is in layer 2,
click on layer 2 to select it if it is not already selected.
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Step 3 From the frame tools:

Pick the shadow tool:

It will immediately apply a shadow, but not necessarily
at a size or position we'd like.  The new shadow is
created just behind the art, in this case, at layer 2.  The
art jumps to layer 3.  Layer 2 remains selected, so it's
the shadow that's now selected.

Step 4 Pick the Squash & stretch tool from the frame tools list:
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Step 5 Mouse down and drag up, changing the vertical size of
the shadow.  When it's a good size, let go.

Step 6 Select the Move cel tool from the frame tools list:
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Step 7 Move the base of the shadow so that it is coincident with
the bottoms of the feet.

Effects from the Exposure Sheet:  Double-Exposure

Let's say we want to do a double-exposure between image "A" and
image "B".  Using conventional equipment, we'd take the "A" and
"B" reels, put them into an optical press, and print it to a new reel
of film.

Here, we place both the "A" and "B" images into the exposure sheet,
in the same frame, and drop the double-exposure icon onto the "B"
layer (or code GLOW into the Notes field in the full data view):

Now What?

Use Play or record again.  You're done!


